SAMPLE QUESTIONS SYBMM SEM IV

Subject- Motion graphics & VFX

Question Optionl Option2 Option3 Option4
Rotoscoping is a technique when you..... ..trace from a
...take a series |...use a video or film
of photos to computer to sequence a ...use cut outs
create createa 3D single frame at [to make a
movement image a time cartoon

If | wanted to adjust the opacity of an object on the timeline window in After
Effects, | would use which shortcut?

The Letter T

The Letter S

The Letter P

The Letter R

What is the file extension for Adobe After Effects projects?

.Psd

.Cdr

Aep

Afx

makes your picture or object, grow or shrink. Once the picture is
selected, in After Effects

Position Rotation Anchor Point  [Scale
What file extension is used by Windows Media Files? .Docx .Psd .Mov .Pptx
What are the different axis you can rotate the object in? X,YAndZ XAndY A, BAndC Only Z Axis
Slowing down the starting or ending movement of any layer is managed by Multiple Minimum Ease In” And Smaller
Keyframes Keyframes ‘Ease Out' Composition
With mode, you can blend or overlap two images on each other and
make it appear as single image. Single Mixing Blending Overlap
In After Effects, The is the technique by which you can select the Mask Select Nest Crop
Which one of these is NOT one of the light types? Point Directional Ambient Parallel
What is the shortcut for Save? S Control S On Pc |Option S On Pc [Shift S On Pc
When a layer is selected, pressing enter will Layer Change The Layer Up In The [Layer Down In
The plugin 'Colour Key' is used to do what?
Remove Dark Light A Scene
Creates A Soft |Spots From Remove Green [Naturally
Natural Light Under Exposed |From Green Without The
Over 3d Layers |Footage Screen Footage |Use Of 3d Lights
After Effects is used to composite Photos Music Document Video
is a process of creating videos by capturing moving Video Audio None Of The
images. Photo Story Production Production Above




CGl stands for... Computer Computer
Computer Generated Graphic Complex
Graphic Images [Imagery Interface Graphics Info
Which of the following does not include in graphics ? Drawing Photograph Movies Music
The quality of an image depend on
Amount Of
No. Of Pixel No. Of Line No. Of Colours |Brightness Used
Used By Image [Used By Image |Used By Image [ByImage
The GIF format is much to be downloaded or uploaded over the www.
Slower Medium Faster Worst
RGB Colour model are used for Computer
Display Printing Painting Documenting
Indian cinemas use standard. Iso Pal Ntsc Hdcam
Monochromatic colours are tint and shades of colour. One Two Three Four
Most basic skill a person requires to pursue an animation career is
skills. Writing Acting Drawing Editing
Sony Creative
Who developed Premiere Pro ? Software Adobe Systems [Macromedia Autodesk
What are the diamonds on the timeline are called ? Stopwatches Points Keyframes Fstops
In which animation, the visual change occurs along three axis namely X,Y and Z?
2d Animation [3d Animation |2d Presentation |Ppt
Premiere Pro project files have the file extension.
Ap .Prem .Prproj .Preproj
In After Effects, Shortcut keys used for zooming in or out on a timeline are
Spacebar + Or - Shift Control Z
Using these keys, you can jump from one keyframe to the next (across
properties), in After Effects H&I J&K L& M |1& 0O
Adobe Premiere Pro is software Compositing Modelling Graphics Editing
Using these keys, you can jump from in point to outpoint of a layer on a timeline
in After Effects H&I J&K L& M | & O




You can use to move from frame to frame of a layer on a timeline, Page Down And

in After Effects Cntrl And Shift |[XAnd Y Page Up Plus And Minus
Page Up & Page

Using these keys, you can move to work area's beginning or end, in After Effects [Spacebar Home & End Shift Down

What are three parts of a video production plan?

Pre-Production,
Mid Production,

Pre-Production,

Pre-Production,
Mid-Production

Pre-Production,
Production And

And Post- Production, And|And Final Final
Production Post-Production [Production Production
You can very easily turn your rulers on and off by hitting Cntrl P Cntrl Q Cntrl R Cntrl S
In Premiere, Which tool should you use to split a clip and create a cut point? Track Select
Cut Tool Razor Tool Selection Tool |Tool
are the components you use to build a composition? Bins Timelines Layers Key frames
What happens to a layer when you turn on its 3d layer switch, in After Effects? The Layer Can
Then Be Moved
And Rotated
Along Its Z Axis You Have To
The Camera In Addition To [It Allows You To |Use 3d Glasses
Layer Is Its X And Y Import 3d To Work On
Created. Axes. Images. Composition
To animate any effects or properties | need to use Still Images Key frames Clips Camera
What tool would | use to create a path for my text
Text tool Pan behind tool |Pen tool Path tool
how can you easily switch to hand tool hand control hand space hold spacebar [hold shift
The shortcut to bring up the Scale property is S P T R
The shortcut to bring up the Position property is
S P T R
The shortcut to bring up the Opacity property is 0 T P S
The shortcut to bring up the Rotation property is S P T R
Pressing 'H' is a shortcut for... Hand Tool Hot Stuff Help Function [Horn




What do you press to start an animation playing in After Effects?

Click on the

Green Play
button on the

Space Bar Ctrl timeline F2
It is a 3D graphics application released as free software under the GNU General
Public License LightWave 3DsMax Blender Maya
A transition between two shots during which the first image gradually disappears
while the second image gradually appears is Cut Fade in Iris Dissolve
How many keyframes are required to create an animation? 1 more than 10
Subject- Theatre & masscommunication Il
Question Optionl Option2 Option3 Option4
---is a long speech delivered by one character Duet Monologue Dialogue Conversation
The ---is the main character in a story that the audience identifies with Role Protagonist Character Antagonist
Stage directions (stage right and left) are decided based on the ---- point of view.

designers producers directors actors
In order to create meaningful and interesting stage pictures, you should
consider all of the following, EXCEPT: Projection levels wings catwalk
A --- rehearsal is one in which the actors perform the show from beginning to
end without stopping for mistakes. Run through tech rehearsal |blocking reading
The --- is a committee of technicians who work behind the scenes of a show
doing the props, costumes, scenery. Cast Grip Designers crew
The -- is at the end of a performance when the actors come onstage to
acknowledge their appreciation of the audience and to take a bow. Curtain call applause wings apron
The theatre involves actors impersonating --- fake people reality characters catwalk
-- is the person responsible for the direction of the actors in a play, that is, the
one who determines such matters as the tempo, interpretation, and the blocking
of the actors. light men directors actors make up artist
---- is the created surroundings in which the action of a play takes place. set props designers make up

Ram ganesh Ratnakar William
"Ekach pyalaaa" is written by --- gadkari Vijay tendulkar |matkari shakespeare
"Vijay tendulkar" was a renowed --- Writer actor dancer singer

Another term for character, as in, "What --are you auditioning for?" conflict intension role singer




--- is the area between the front edge of the stage and the first row of audience

seats where the orchestra can play music during a musical wings apron pit Backstage
---is the created surroundings in which the action of a play takes place. props set character design
The --- style stage is the most popular and has an audience on one side, a pit, an
apron, and a main drape. thrust proscenium black box arena
---is the point where revelation of the backstory happens through dialogues
arc actions exposition conflicts
---is done by the characters to achieve their objectives conflict arc script actions
The ending is called --- resolution spine actions arc
The final confrontation between the protagonist and the antagonist is called ---
actions climax arc stakes
A ---is called as different actions in a play ad beat song music
--—-is a NSD alumni varun dhawan [neetu singh om puri katrina kaif
Om puri has own national award for ---- mandi gupt aakrosh ardha satya
---won national award 5 times Anushka
sharma salman khan shabana azmi |Rajesh Khanna
Two actors that play the main roles in a movie are: doubles co actors co stars actors
An element in drama that evokes sorrow and compassion? closet drama folk theatre pathos chorus
A performance
Improvisation is defined as: A rehearsed that is done An
scene without |without unrehearsed,
props rehearsal scripted scene |make up
---- is an extended speech by one character, alone on stage, and used to
express the private thoughts of one character. monologue aside script Soliloquy
Which of the following is NOT a function of stage lighting? visibility mood Plausibility unity
The responsibilities of the Assistant Director include all of the following EXCEPT
setting up reading lines of |design
take attendance(rehersal room |absent actors [costumes
"Hasya" means --- Joy Anger Love Fear
"Sringara" means --- Wonder Courage Sorrow Love
"Adbhuta" means --- Surprise Anger Disgust Sorrow
"Vira" means Courage Joy Fear Love




"Shantaa" means --- Peace Sorrow Anger Courage
"Karuna" means --- Love Joy Sorrow Disgust
"Raudra" means --- Anger Courage Love Fear
"Bhayanaka" means --- Fear Love Sorrow Disgust
"Vibhasta" means ---
Wonder Fear Disgust Love
--- can be defined as the actions or reactions of a person in response to external
or internal stimulus situation
Behaviour Observation Writing Direction
Using realistic plots------ explores the forces that influence the human
condition. Naturalism Realism Theatreism production
Notes in the text of a play that describes how the work should be performed or
staged called what? stage directions |aside dialogues monologues
where a person |the way person |car that is
External traits include --- emotions lives walks owned
---is a type of character which is always on the side of protagonist static foil flat dynamic
--characters do not change throughout the story foil round stock static
---characters change throughout the story round static dynamic foil
To be able to tell a story through written word for the theatre director producer actor playwriter
--has to gather data and do a research producer playwriter director actress
This person conducts rehearsals director actor writer make up artist
The backbone of a production is the: actor directors callbacks promptbook
Subject- Mass media research
Question Optionl Option2 Option3 Option4
What in research is crucial to expressing the originality and value of your own identifying a data analysis observation hypothesizing
research? gap
What does 'APA' stand for? Australian African American American
Psychological Psychological Psychological People's
Association Association Association Association




Which among the following options cannot be considered as a keyword for the |Self-perception |Adolescents Pupil Dilation  |Body Image
literature review of the title " Psychological Effects of Social Media on GEN Z"?
A sample is the subset of the population that is taken to be representative |applicable to equal to unequal to
the entire population. of
If the goal is , sampling will involve practical procedures transferrability [generalizability |applicability reliability
possible for gathering a sample that best represents a larger population.
What is the unit of analysis of a study on 'classroom climate'? Classroom students teachers individuals
cannot be calculated in non-probability sampling technique. Results Sampling error |Population Representative
error ness
What sampling is used when working with populations that are not easily Quota sampling |Snowball volunteer convenience
identified? sampling sampling sampling
Which amongst the following is not an advantage of random sampling External validity [Easy to perfrom |Highly Classification
technique? representative [erroris
sample is eliminated
obtained
What type of non-probability sampling technique involves selecting subjects on |Volunteer Purposive Convenience Snowball
the basis of certain characteristics ? sampling sampling sampling sampling
What sampling technique will have to be used when the universe of the study is |Multi-stage Hybrid sampling|Stratified Cluster
an entire country? sampling sampling sampling
A test in which an individual is given a clue or hint and asked to respond to the |Completion Construction Expression Word
first thing that comes to mind. Test Test Techniques Association Test
Respondents indicate their own attitudes by checking how strongly they agree or|Guttman Scale |Likert Scale Constant Sum [Semantic
disagree with statements. Scale Diffrential Scale
The summated rating scale is also known as the Stapel Scale Cumulative Likert Scale Thurstone Scale

Scale




A technique used for measuring qualitative responses of respondents is called as [Survey Method |Indepth Questionnaire |[Scaling
Interview
_____isequal to lottery system in sampling. Snowball Quota Sampling [Convenience Random
sampling Sampling Sampling
Sample is a part of given Data Population Audience Selection
Which of the following is NOT Secondary Data Collection Method? Newspaper Journals Magazines Interview
_____issuitable method for gathering information from illiterate or less Case Study Interview Survey Simulation
educated respondents.
as a method involves both 'seeing' and 'hearing' Interview Case Study Observation Data
______comprises of readily available data and compiled statements whose data Primary data Reports Secondary Data |Statistics
maybe used by researcher for studies.
Cluster Sampling is also knownas Stratified Multi-stage Random Quota Sampling
sampling sampling Sampling
Which of the following is NOT probability sampling? Random Systematic Stratified Snowball
Sampling Sampling Sampling Sampling
In___ observation, the investigator remains aloof from the activity and Participant Interviewer Non-participant |Experimentatio
observes the event from a distance in a passive manner. n
____sampling is a Non-Probability sampling. Quota Sampling | Multi-stage Systematic Random
sampling Sampling sampling
Interviewing all members of a given population is called: Sample Gallup poll Census Nielsen audit
A is testable and predicts relationship between variables Hypothesis Variable Research Sample
Which of these is not a type of hypothesis? Descriptive Null Alternate Quantitative
Rejection of the Null hypothesis leads to the acceptance of the hypothesis |Null Alternative Descriptive Relationship
is defined as a method of viewing and recording participants. Case Study Survey Observation Descriptive
reserach seeks to find cause and effect relationship between
variables. Causal Exploratory Historical Descriptive
serves as a base or raw material for analysis Hypothesis Sample Data Research
data is first hand information collected by the researcher Primary Secondary Qualitative Quantitative




The

source consists of readily available and already compiled statements

and reports. Primary Secondary Qualitative Quantitative
Personal
Which of these is not an example of primary source of data? Survey interview Observation Journals
Personal Financial Statistical
Which of these is not an example of secondary source of data? Census reports |interview statements statements
Simulation is a type of data collection. Secondary Qualitative Primary Quantitative
Laboratory Field School Office
Data collection done in a non simulated atmosphere is known as experiment experiment experiment experiment
Which of these is not a type of interview? Structured Unstructured [Focused Case Study
interviews are limiting, as researcher cannot observe the body Group
language of the participant. Telephone Face to face Survey discussion
techniques involve presentation of stimuli to be interpreted by the Projective Close ended
respondents Statistical techniques questions MCQ's
A respondent is asked to role play a specific concept or situation in a
technique. Expressive Case study Face to face Survey
is very important is marketing and advertising. Design Location Research Activities
variables affect of have an impact on other variables Dependent Independent Continuous Discontinuous
A variable is the third variable that affects the relationship between the
dependent and the independent variable. Moderating Independent Continuous Discontinuous
Variables that might influence the outcome of an experiment are called Moderating Independent Continuous Extraneous
may not be apparent today but can become a problem after Overt Latent Active Research
sometime difficulties difficulties difficulties problems
A is a proposition put for verification which may be right or Environmental [Qualitative Moderating
wrong. conditions variable variable Hypothesis
Meaning produced and conveyed in messages that are primarily seen are known
as semiotics. visual audio kinaesthetic olfactory




Research process consists of __ steps. 6 5 8 9

Subject- Film communication Il

Question Optionl Option2 Option3 Option4d
Golden Lotus Award (Swarna Kamal) is awarded in the category of Best Film National Film Zee Cine Screen Film
Criticin Awards Filmfare Awards|Awards Awards

Golden Lotus Award (Swarna Kamal) is awarded in the category of Best Book on Zee Cine Screen Film National Film
Cinemain Filmfare Awards|Awards Awards Awards
"Best Film on Environment Conservation / Preservation" is a category of award in[National Film Zee Cine Screen Film
Awards Filmfare Awards|Awards Awards
National Film Zee Cine Screen Film
"Best Film on National Integration" is a category of award in Awards Filmfare Awards|Awards Awards




Presented first in 1969, the award was introduced by the Government of India to|Prithviraj Dadasaheb

commemorate ’s contribution to Indian cinema. Kapoor Sohrab Modi Phalke Ashok Kumar

Who was the first recipient Dadasaheb Phalke Award? Nandita Rani Devika Rani Devashree Rani |Nandini Rani

In 67th National Film Awards for 2019, won the award for Most Film

Friendly State. Maharashtra Uttar Pradesh  [Sikkim Assam
the Golden the Golden

The Academy Awards are popularly known as Palm the Oscars the Golden Bear|Leopard
Academy of Academy of Academy of Academy of
Motion Picture |Magic Picture |Method Picture |Maya Picture

The Academy Awards are given annually by the Arts and Arts and Arts and Arts and
Sciences Sciences Sciences Sciences
(AMPAS) (AMPAS) (AMPAS) (AMPAS)

At the Academy Awards the various category winners are awarded a copy of a

golden as a trophy. leaf apple globe statuette




The statuette of the Academy Awards depicts a rendered in the Art

Deco style. lion tiger knight monk
has been nominated for Best Actor in a Leading Role for Sound of

Metal in the Academy Awards. Kumail Nanjiani [Riz Ahmed Faran Tahir Usman Ally
has been nominated for Best Actor in a Leading Role for Ma Rainey's|Michael B. Denzel Chadwick

Black Bottom in the Academy Awards. Jordan Washington Idris Alba Boseman
has been nominated for Best Actor in a Leading Role for The Father |Anthony

in the Academy Awards. Hopkins Jack Nicholson [Richard Gere Paul Newman
has been nominated for Best Actor in a Leading Role for Mank in the

Academy Awards. Alec Baldwin Gary Sinise Gary Oldman Kevin Costner
has been nominated for Best Actor in a Leading Role for Minari in

the Academy Awards. Donnie Yen Steven Yeun Ken Watanabe |Chow Yun-fat
has been nominated for Best Actress in a Leading Role for Ma Frances

Rainey's Black Bottom in the Academy Awards. Viola Davis Andra Day Vanessa Kirby  [McDormand
has been nominated for Best Actress in a Leading Role for The Frances

United States vs Billie Holiday in the Academy Awards. Viola Davis Andra Day Vanessa Kirby  [McDormand
has been nominated for Best Actress in a Leading Role for Pieces of Frances

a Woman in the Academy Awards. Viola Davis Andra Day Vanessa Kirby |McDormand
has been nominated for Best Actress in a Leading Role for Frances

Nomadland in the Academy Awards. Viola Davis Andra Day Vanessa Kirby |McDormand
has been nominated for Best Actress in a Leading Role for Promising

Young Woman in the Academy Awards. Viola Davis Andra Day Vanessa Kirby  [Carey Mulligan

Who is the director of the film The Father (2020)?

Florian Zeller

David Fincher

Lee Isaac Chung

Simon Stone

Who is the director of the film Mank (2020)?

Florian Zeller

David Fincher

Lee Isaac Chung

Simon Stone

Who is the director of the film Minari (2020)?

Florian Zeller

David Fincher

Lee Isaac Chung

Simon Stone

Who is the director of the film The Dig (2021)?

Florian Zeller

David Fincher

Lee Isaac Chung

Simon Stone




The Palme d'Or

The Golden

.......... is the highest prize awarded for the best film at the Berlin International |The Academy [(English: Golden|Bear (German:

Film Festival. Awards Palm) Goldener Bdr) [The Golden Lion
The Palme d'Or [The Golden The Golden Lion

The Academy [(English: Golden|Bear (German: [(Italian: Leone

.......... is the highest prize given to a film at the Venice Film Festival. Awards Palm) Goldener Bar) [d'Oro)
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character, then the .......... film is richest in mood or atmosphere in presenting

characters in their own surroundings. Japanese Indonesian Chinese Malaysian

"This patient observer of everyday life in Japan has been enormously influential
among filmmakers seeking a cinema of economy and poetry." For which
filmmaker is the statement true?

Akira Kurosawa

Yasujiro Ozu

Hayao Miyazaki

Takeshi Kitano

Who directed the Japansese film Tokyo Story?

Akira Kurosawa

Yasujiro Ozu

Hayao Miyazaki

Takeshi Kitano

Yasujiro Ozu's film follows an aging couple’s journey to visit their grown
children in bustling postwar Tokyo. It surveys the rich and complex world of
family life.

Beijing Story

Kuala Lumpur
Story

Tokyo Story

Jakarta Story

Yasujiro Ozu's film tells the story of two young boys who stop speaking in
protest after their parents refuse to buy a television set.

Good Morning

Tokyo Story

Late Spring

Early Summer

Who directed the Japansese film Good Morning?

Akira Kurosawa

Yasujirdo Ozu

Hayao Miyazaki

Takeshi Kitano

Which film by Yasujiro Ozu is the following description of: The last film by
Yasujirdo Ozu was also his final masterpiece, a gently heartbreaking story about a
man’s dignified resignation to life’s shifting currents and society’s modernization.
Though the widower Shuhei (frequent Ozu leading man Chishu Ryu) has been
living comfortably for years with his grown daughter, a series of events leads him
to accept and encourage her marriage and departure from their home.

Good Morning

Tokyo Story

Late Spring

An Autumn
Afternoon

Who directed the Japansese film An Autumn Afternoon?

Akira Kurosawa

Yasujiro Ozu

Hayao Miyazaki

Takeshi Kitano

was the first Japanese film director to win international acclaim, with such
films as Rashomon (1950), Ikiru (1952), Seven Samurai (1954), Throne of Blood
(1957), Kagemusha (1980), and Ran (1985).

Akira Kurosawa

Yasujirdo Ozu

Hayao Miyazaki

Takeshi Kitano




Kurosawa’s .......... was shown at the Venice Film Festival in 1951 and was
awarded the Grand Prix. It also won the Academy Award for best foreign-

language film. Kagemusha Rashomon Seven Samurai |lkiru
century; a rape and a murder are recollected by the four persons in distinctly

different ways. This presentation of the same event as seen by different persons [Seven Samurai |Kagemusha Ikiru Rashomon
"It depicts a village of peasants and a few leaderless samurai who fight for the

village against a gang of marauding bandits." This is the basic plot of which film

by Akira Kurosawa? Kagemusha Rashomon Seven Samurai |[lkiru
Somewhat ironically, Kurosawa’s film .......... later served as the inspiration for

one of the greatest American westerns, John Sturges’s The Magnificent Seven

(1960). Seven Samurai |Kagemusha Ikiru Rashomon

Films of .......... represent a unique combination of elements of Japanese art—in
the subtlety of their feeling and philosophy, the brilliance of their visual
composition, and their treatment of samurai and other historic Japanese
themes—with a distinctly Western feeling for action and drama and a frequent
use of stories from Western sources, both literary classics and popular thrillers.

Akira Kurosawa

Yasujiro Ozu

Hayao Miyazaki

Takeshi Kitano

A wealthy industrialist's family becomes the target of a cold-blooded kidnapper
in Akira Kurosawa's ..........

Ran

Yojimbo

High and Low

Throne of Blood

Akira Kuroswa's High and Low is an adaptation of Ed McBain's detective novel

King's Ransom

King's Speech

King's Voice

King's Price

The entertaining plots, compelling characters, and breath-taking animation in his
films have earned him international renown from critics as well as public
recognition within Japan. He is also known as the Japanese Walt Disney. For

Akira Kurosawa

Yasujiro Ozu

Hayao Miyazaki

Takeshi Kitano

In 1985 Hayao Miyazaki co-founded .......... , a film and animation studio in Tokyo

with, Isao Takahata and Toshio Suzuki. Studio Ghibli Studio Jhabli Studio Jalebi Studio Baraelli
Hayao Miyazaki's .......... received the Japanese equivalent of the Academy Award Princess

for Best Film and was the highest-grossing (about USDS$150 million) domestic The Wind Rises |Mononoke My Neighbour |[Castle in the Sky
film in Japan's history at the time of its release. (2013) (1997) Totoro (1988) |(1986)




Unlike other directors, does not make or need a script, he simply draws an
image and then builds an entire story around that image.

Akira Kurosawa

Takeshi Kitano

Yasujiro Ozu

Hayao Miyazaki

Hayao Miyazaki is a purist, so ...

...the frames in
his films are
completely
hand drawn,
with CGl only
being used to
assist with
complicated
scenes or to
speed up
production.

...the frames in
his films are
completely
computer
generated, with
hand-drawn
images only
being used
sparingly.

...the frames in
his films are
completely
hand drawn,
with no CGI
used.

...the frames in
his films are
completely
computer
generated, with
no hand-drawn
images used.

Magic, anti-modernism, flying and feminism are signature themes used frquently
in his films by

Akira Kurosawa

Yasujiro Ozu

Hayao Miyazaki

Takeshi Kitano

"He does not set boundaries between what ‘male’ and ‘female’ characters can
do. Each female character is as unique as the other. And the representation of
his female characters seems very real." This is true of which filmmaker?

Takeshi Kitano

Hayao Miyazaki

Yasujiro Ozu

Akira Kurosawa

Subject- Computers & Multimedia ll

Question

Optionl

Option2

Option3

Option4d




Choose Modify
> Templates >

Choose File >

Apply Template |Preview in
to Page > Browser >
Choose File > |Choose an Device Central, |Choose View >
Convert > XHTML Mobile |and choose the |Style Rendering
You create a Web page that you want to display on a mobile device. You want to |[XHTML Mobile |1.0 enabled mobile device [>Handheld
preview the Web page to ensure that the Web page content is displayed 1.0, and press |template, and [from the list of [Media Type,
correctly on a selected mobile device before you publish it. What should you do? [F12. press F12. the devices. and press F12.
Use the New Use the Code |Use the File Use the Code
Document Rewriting Types / Editors [Format
You want to set the default encoding for an HTML page. What should you do? category. category. category. category.
You create a Web page and link it to an external CSS file. You copy a table with
formatted text from a Microsoft Word document to the Web page by using the |[CSS classes are |CSS IDs are
Paste Special option. From the Paste Special dialog box, you select the Text with |added to the added to the CSS classes are [CSS IDs are
structure plus full formatting option. What is the expected result when you copy |external style |external style |created in the |createdinthe
the table to the Web pag_e'.i ; sheet. sheet. Web page. Web page.
browsers which are listed in the Web browser list defined in Dreamweaver. Browser List Browser Preview in Validator
What should you do? option in the Compatibility  [Browsers category in the
are key components of any webpage, both for developing visual
interest and for telling stories in dreamweaver. Images Colour Pages Files




Click on the

In Split View image and you
right-click on get Edit HTML
the desired Change image [Create new site |Attributes to
image to open |properties for changing change the
In order to change some properties of an image how will you perform the task in [image before inserting [image image
dreamweaver? properties into the page. |properties properties.
td a:hover { td, a.hover {
font-weight: td a.hover { font-weight:
bold; text- font-weight: bold; text-
td a:hover { decoration: bold; underline: |decoration:
font-weight: none; none; none;
What set of Cascading Style Sheets (CSS) style rules cause hypertext links within |bold; underline: |background- background- background-

a table data cell to appear bold, not underlined, and with a pale gray background

none; -color:

color: #CCCCCC;

color: #CCCCCC;

color: #CCCCCC;

when the user moves the mouse pointer over a link? #CCCCCC; } } } }
What area, in the Insert bar, is intended for customizing and organizing
frequently used objects? Layout Common Favourites Application
A page has an embedded style sheet that redefines H3 as Arial, red. The same Arial, red,
page has a linked style sheet attached that defines H3 as Verdana, blue, and 16 |Arial, red, 16 Verdana, red, |Verdana, blue, [browser default
pixels. How should text between H3 tags display on the page in a browser? pixels 16 pixels 16 pixels font size
Which symbols could be used to start a comment in JavaScript? // or/* # S {
<a <a <a
The left frame of a frameset has the name of "nav" and the right frame of a href="jan.htm" |href="jan.htm" [<a href="jan.htm"

frameset has the name of "main". The links in the "nav" frame need to display
pages in the "main" frame. What is the target for the link?

target="_main"
>

target="_parent
Il>

href="jan.htm"
target="main">

target="parent"
>

In Dreamweaver <video> tag selector starts the video

automatically after the webpage loads. AutoPlay Controls Loop Preload
In Dreamweaver <video> tag selector displays visible video

controls. AutoPlay Controls Loop Preload
In Dreamweaver <video> tag selector causes the video to replay

from the beginning automatically once it finishes. AutoPlay Controls Loop Preload




In Dreamweaver <video> tag selector specifies the method in

which the video loads. AutoPlay Controls Loop Preload
is very memory-and bandwidth-intensive in Dreamweaver. Video Audio CSS GIF
comes in many different formats. It can be almost anything you can hear
or see, like images, music, sound, videos, records, films, animations, and more. |[Multimedia Tags Selectors Websites
If your website is about recorded music, is the best format for
compressed recorded music. MP3 WMA MIDI WAV
A Dreamweaver behavior is predefined code that performs
an action —such as opening a browser window or showing or hiding a page
element— when it is triggered by an event, such as a mouse click. Applying a
behavior is a three-step process: 1. Create or select the page element that you
want to trigger the behavior. 2. Choose the behavior to apply. 3. Specify the
settings or parameters of the behavior. JavaScript CSssS HTML C++
Window > Window > Window > Window >
How to access the Dreamweaver Behaviour Panel Behaviours Browse Addons |Properties Results
Which Dreamweaver workspace is recommended when you are a beginner . Standard Developer New Workspace|None of These
A image is a secondary image loaded into your page to display when a
visitor to your site 'rolls over' a certain image within your site. It is used to make
your site more interactive and may be used to display different views of a same
image, or alternative products, etc. rollover background swap raster




Which option in Dreamweaver helps a user to change link on a webpage.

Edit > Link >
Change Link

Edit > Link >
Remove Link

Edit > Link >
Open Linked
Page

Insert >
Hyperlink

Site > Advanced

Site > Site

Site > Manage

How do you publish sites on web using Dreamweaver? > FTP Log Options Sites Site > New Sites
What is the shortcut key for rotate tool in Illustrator? P Q R S
What is the shortcut key for reflect tool in Illustrator? S 0] T C
by using expand
How can we convert a stroke into a fill object? by recreating it |by pen tool by resizing command
What is file extension for an illustrator file? il .ai .ia Jif
What is the shortcut key to change the artboard in illustrator CtrlM CtrIN Shift O Alt P
Radial, Grid, Add, Subtract, |Blend, Expand, |[Rotate, Reflect,
What are the 3 modes of command repeat in illustrator? Mirror Intersect Create scale
What is the purpose of masking in lllustrator? to hide to show to cut to add
Opacity is Filled color Transparency [Scale Rotate
What are the 2 color modes in lllustrator? RGB and CMYK |CMYK and HSB |HSB and RGB HSB and Lab
In the middle of working with pen tool, if we want to pan in an artwork, what
shortcut key should we use? Alt Shift Space Ctrl
What is the shortcut to unhide objects in Illustrator? Ctrl+Shift+3 Shift+Ctrl+3 Ctrl+Alt+3 Alt+Ctrl+3
How many text cases are there in Illustrator? 2 3 5
to use
to take double |to create to separate adjustment
To apply gradient on text we have to text layer outlines for text [every word layer




If we have to type a circular text what tool should we use?

Type tool

Vertical type
tool

type on path
tool

area type tool

In illustrator a rectangle does have the points to convert corners into curves,

where are they placed? Inside corners [Outside corners |Center on the corners
What is the shortcut key for Ellipse tool? L 0] P M
What are the least number of sides polygon have in lllustrator? 6 5 4
What is the shortcut key for Gradient tool? H G P M

create

cover pragraphs

If we have to surround an object by text paragraph, what tool we should use? Cover object Text wrap paragraph around object
What is the shortcut key for duplication? Ctrl T Ctrl L CtrlD Ctrl M

Program
Which panel displays a representation of what your final program will look like? |Capture Project Source Monitor |Monitor
Which option lets you export a single frame from the source Monitor or Program [Compositing > |Clip > Export > [Click the export |Right Click in
Monitor panel? Render > Still  [Still frame button [the panel
The marker makes it possible for certain video servers to divide Comment Segmentation |Write Clip
content into parts. Marker Chapter Marker |Marker Markers

Sony Creative |Adobe Systems

Who Developed Premiere Pro Software Incorporated |Adobe Systems [Macromedia
Dreamweaver is sold by what software company: Adobe Macromedia Microsoft Google
Subject- Writing and editing for media
Question Optionl Option2 Option3 Optionl




Using a green
screen allows

you to "be"
anywhere green is not
without actually present in the
going there green clothis |light color
What is the role of green screen in televsion. yourself. less expensive [spectrum both b and ¢
which type of radio personalities often discuss social and political issues from a
particular point of view. FM radio Talk radio Sports Talk AM radio
back
is a way of distributing audio files via the Internet. announcement |Webcasting Tail enders Podcasting
Opener,Proble
m Opening, Opening,

Statement,Solut

Evaluation,

Report,Evaluati

ion and Call to |Rereading,Call |Opening,Act, on and Call to

What is a basic structure of effective marketing video ? action to Action Plan and Reflect|Action

A is when the newsreader breaks into a program onair to read an

important ,urgent news story, such as major disaster or the death of a national

leader. News Flash Grab stings autocue

A brings Audio and Video production people of differing

opinions and viewpoints on to one platform. Straight talk Interview Feature Panel discussion

outdoor

Footage of construction firm CEOs being interviewed on building sites is a best  |sound bite broadcast

example of : interview Skype interview |interview sofa interview
Formalistic Ambush

Door step interview is also called interview interview Skype interview [sofa interview

Recorded sound are called actuality flaneur Chiasmus Hyperbaton

Contemporary
gives details of every program that is aired. Rundown sheet |Lyrical sheets [Chronicle sheet [sheet

Which among the following is not format of storyboard? Straight shell Testimonial Dramatization |[Ballads

In which type of format a single topic or subject is chosen for presentation and

discussion of facts, opinions, beliefs , arguments, controversies and counter-

arguments . Story talk straight talk Interview Feature




type of television programme format is a basic story telling just like it

is used in theatre and play. Interview Panel discussion|Feature Drama
magazine
One of the oldest format of radio is? Radio interview [announcements|programs radio talk show

Online radio was pioneered by

Carl Malund

Tom Stppard

Edward Bond

Richard Hoggart

Which among the following is correct description of doorstep interview.

interviews are
commonly used
in corporate
videos.

conducted with
an individual
who is
separating from

It is scary and
intimidating .

bothaandb

Broadcasting on the internet is usually referred to as since it is not

transmitted broadly through wireless means. Webcasting podcast Script template |Globalcasting
add relief and a change of pace to heavy bulletins. Headliners Beginners Frontrunners [Tail-enders
Never use as background to a news bulletin. It is distracting and Closing
ruins any variations in pace within the bulletin. music headlines Tail enders Closing stories
are short stories,no longer than one or two sentences each.They are
not designed to tell the whole news ,simply to let people know that something
has happened. Briefs news flash Message Bulletin




always shy do not respect |are blindly
away from the inteligence |[opinionated in |do not shy away
Professional reviewers whether they thought the movie was good, |[telling their of their readers |telling their from telling
bad, or indifferent. readers by telling them |readers their readers
be overtly
either in favour how far to go
of or be against |decide what with his decide how
the filmmaker |elements of the |opinions in personal to get
whose work he [movie to reviewing a while reviewing
For a film reviewer knowing who his readers are can help him ... is reviewing. highlight. film. a film.
A film reviewer should give his readers some idea of the plot, but be careful not [minutest of
to include any . details. details spoilers. tidbits.
is a brief summary, containing most of the Five W’s and H in one First-person
sentence. Straight lead lead Descriptive lead [Quotation lead
‘You’ lead or
The is intended to make a personal appeal to the reader involved in direct reference
a complicated situation. Zinger lead Delayed lead Blind ID lead
____media uses electronics or electromechanical energy for audience to access
content Print OOH Electronic Pamplets
The first television channel in India was Zee Sony Star Doordarshan
was the first medium for broadcast journalism TV Radio Internet Blogs
The first news channel to provide 24 hours news service was CNN BBC TN NDTV
In 1959, came into exitence Magazines Newspapers Radio Television




is more popular in rural areas TV Internet Magazines Radio
Announcers on radio are better knownas ___ RJ DJ M) S
The CNN covered the war non-stop Gulf Berlin Kargil World War Il
Star Mazha is now known as Zee Sony ABP Times
Ramanand Sagar was the creator of series Mahabharata |Ramayana Bhagwat Geeta |Hanuman
is the editor of ABP Mazha Bharat Raut Sanjay Raut Nikhil Waghle [Rajiv Khandekar

B.R.Chopra produced the epic series Mahabharata [Ramayana Bhagwat Geeta [Hanuman

is the text version of a programs dialogue overlaid on the screen Subtitles Sound Byte Rundown News Feed
In 1984 TV entered India B/W Colour Cable Dish
The DTH Service of DD is called Tata Sky DD Direct Plus DD Dish TV DD Fast
Television was invented by J.L. Baird Thomas Edison [Graham Bell Steve Jobs

The ABP in the APB group stands for

Akhanda Bharat
Patrika

Ananad Bharat
Patrika

Akhanda Bazaar
Patrika

Anand Bazaar
Patrika

Which of the following TV Channels deal with political proceedings in India

Star Gold

Epic

Lok Sabha TV

ANI News

In 2019, which India Journalist received the Ramon Magsaysay award?

Arnab Goswami

Rajat Sharma

Prannoy Roy

Ravish Kumar

In a TV script, there are video columns 1 2 3 5
Typically in a TV script, there are cameras 6 7 3 2

A ticker or graphic must appear after seconds in a TV script 45 75 10 15

Which of the following TV Channels deal with political proceedings in India Star Gold Epic Lok Sabha TV |ANI News
FM is a term associated with ___ Print Radio TV Internet

Subject- Media laws & ethics




Question Optionl Option2 Option3 Option4
Defamation that is communicated by a writing is called slander libel Invation of deceit
privacy
To be, actionable defamation must be conveyed to the|an invasion of |[communicated |in writing
subject the subject's to a third party.
privacy
The wrongful act of damaging another’s character or reputation by the use of defamation libel slander demage
false statements is called
A company wishes to ensure that no one else can use their logo, they have to copyright trademark intellectual Geographical
protect themselves under design indications
Which of the following is not an mtellectual property law? Copyright Act, |Trademark Act, |Patent Act, Customs Act,
1957 1999 1970 1962
Intellectual Property Rights (IPR) protect the use of information and ideas that  |Ethical value Moral value Social value Commercial
are of value

In India, the literary work is protected until Lifetime of 25 years after |40 after the 60 years after
author the death of death of author [the death of
author author
What types of work can be copied? only literary all literary & all type of all type of work
work musical work [literary & that lacks
musical work  |originality
that is original
ITA-2000 is known as indian Information international industrial
television Technology Act |team’s Alliance |technical
awards association
FIR means File First forwarded File Information
Investigation Information information Register
Register Report report
In IT Act Adult term described as 60+ 25+ 50+ 18+




Under section 66A what is offensive message? menacing criminal spreading menacing
character intimidation hatred character,
criminal
intimidation
and spreading
hatred
Which of these sections of the IT Act is not functional now? Section 66 Section 66A Section 67 Section 67A
Section 67 of the IT Act mentions Corruption obscene nudity Terrorism
information in
electronic form
The punishment for violatation of Section 67 of the IT Act is upto 10 years [Fine of rs 2 10 Years of 5yearsin
imprisonment |Lakhs Imprisonment |imprisonment

and fine upto Rs
2 lakhs

and fine of rs 10
lakhs

Section 67 is not applicable for which of the following representations |representations [menacing sexually explicit
and figuresin |and figuresin |character, content,
electronic form |electronic form [criminal depting
which are kept |which are kept [intimidation childrent in
or used for or used for and spreading |obscene
religious bonafide hatred manner and
purposes. heritage or abusing

religious children online
purposes
uses sensationalized headlines to grab the user’s attention Click-bait Filter bubble Whatsapp Parody
As per the NBA guidelines the will monitor the broadcasts made|CBI Police Judiciary Election

by news broadcasters from the time elections are announced until the
conclusion and announcement of election results.

Commission of
India

Due to the unethical & sharp use of advertising in the early 20th Century, a call
for was made by some advertisers in order to
avoid giving the control away to the state.

Drug-Regulation

Competition Act

Company Act

Self-Regulation




Katrina Kaif’s Commercial of slice became famous because of her subtle Aamsutra “Karmasutra Mangosutra Kamasutra

seductive act in the advertisement which was known as

Utilitarianism is an approach to ethics that means Whatever does [Fairnessis the [Journalists Not all ethical
the most good |fundamental often face precepts can be
for the most aspect of conflicts among |applied in all

number of
people is best.

ethical conduct
and peoplein a
dispute should

ethical
principles in the
course of their

situations, but
they do provide
useful

look at the work and must |guidelines for
situation often make media
outside of their |difficult professionals in
own vested decisions. their behavior.
interests in the
outcome to
decide what is
right.
is the study of how to manage oneself ethically, professionally and in|Rule of law Code of Army [The Digital Ethics
a clinically sound manner via online and digital mediums Brotherhood of
Steel
was the inventor of the World Wide Web. Mark Kunal Shah Jim Lee Tim Berners Lee
Zuckerberg
means willfully created and disseminated false information with Puffery Surrogate Subliminal Dis information
known harmful intent.
The Society for Business Ethics was started in . 1988 1980 1984 1985
advertising isn't just about acknowledging and embracing the LGBT
. . Proud . .
community ,it’s an opportunity for brands to take a stand. Profit Pride False
The Copyright Act year is 1957 1988 1990 1989
is false advertising that misrepresents the price, utility and purpose of a [Paid search Fake Unfair Fair
product or service. Advertisement |Advertisement |Advertising Advertisement




The , is a landmark legislation to promote competition and curb Information
monopoly and anti-competitive agreements, by restricting the abuse of an Technology The RTI Competition Act|Official Secrets
enterprise's dominant position in the market. Act,2000 Act,2005 2002 Act,1923
The is an integral part of the right to life and personal freedom under Right to Fundamental
Article 21. Right to know |Right to privacy |Information right
came into light by the release of the documents of the 2016 Rafale
jet deal between India and France. RTI Act Competition Act|OSA Act IT Act
Consumer Protection Act year is 1990 1999 1987 1986
SARC made recommendation for OSA in 1999 2000 2006 2002
Contempt of court was enacted for the first time in the year 1952 1962 1972 1982
2 yearsto life |3 years to life Life
Punishment under the OSA Act range from imprisonment [|imprisonment |1 year imprisonment
is a legal right for every citizen of India. OSA IT Act RTI Competition Act
right treatment
to the
Which of the following factors encourage good ethics in the workplace? transparency |employees fraud bribe
ads about ill
exaggerated kids eating effects of
Which of the following is not an ethical issue in advertisement advertisements |healthy food children in ads |alchohol
goodness in human social
The study of ethics helps us study the ---- goodness in life [human action |social behaviour{behaviour
fights Poor quality
Which of the following are an advantage in Advertisement ? competition Stereotyping product Opportunism
The Indecent representation of Women (Prohibition) Bill was proposed on 14th 7th 9th 13th
December,2012 |December,2012 [December,2012 [December,2012
Consumer Information
"The Hindu newspaper ,which has published the papers of the Rafale Fighter jets |Competition Official Secrets |protection Technology
case details should be tried by the government under the Act,2002 Act,1923 Act, 1986 Act,2000
of the Constitution of India states that "No person shall be deprived of
his life or personal liberty except according to procedure established by law". Article 19 Article 21 Article 17 Article 8




The Trade and Merchandise Marks Act year is 1970 1950 1958 1969
is yet another deceptive advertisement tactic where customers are Sloppy

lured by displaying cheap prices to get them into the store. Bait and Switch |Native Fake

The strongest legal protection provided to personal information in India is

through section of the IT Act. 40A 40B 43A 43A(2)

The Official Secrets Act was first enacted in the year 1990 1950 1923 1970

are expected to be shown as Nurturers and caregivers . Children in ads [Women in ads Zzzlor citizen'in Men in ads

The Consumer |[The The Information
protection Competition Technology The Official

50 cases of violation of were registered in the country so far since 2014.|Act,1986 Act,2002 Act,2000 Secrets Act

Right to Information Act year is 2005 2011 2009 2000




